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web B B IAAERNAEEH

— BENAR

web E ZALIMHAHE 22 2 T selenium + maven + testng + github +Jenkins & 2], H. ] selenium
FoR 2% 5 MR AHB], maven HTIH M, testng F THATINK, A4 THATH, github
AT AREFEE, jenkins F THFEEERN. BANEZL T SEILAGI B 2P AT IE0. RIS H
B Az E R RSB A S8, I BEMHEZLEER T jenkins, AT A D REREH I A
FAAG) e I HRFE AR T 2 fm BIdR 5 mT L@ jenkins BSAF IR S5 RS RKIBZEHH RN
Fio {EMEEAAT selenium, selenium s&—/NMH T Web B HFEF M T E. Selenium
MRX B AT EN A, WUR E AR AR E — o SCREI AR B35 1E(7. 8. 9. 10,
11). Moxzilla Firefox. Google Chrome %, HI T2 JAVAIE S 'S, FTULEGE G, XK
windows. Linux Il MAC OS 5. Selenium & ThoughtWorks %[ 74 Web N 2 ¥ 4% 5 1) — 1
B T A .

e AHEZ A B T RAGE TR, Aok TH, O T Z4HO /R A .

—. BX@EWE
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4 H logisticsautotest [automation master]
4 % srcftestfjava
4 ] com
a4 ] incito.logistics
: Hj base
- H} pages
. Hj testcase
- H wtil
. H} netease.ga.testng
» = Maven Dependencies
» =i, JRE System Library [JavaSE-1.7]
4 [ config
[ config.properties
E logdj.properties
4 [ extral
> |2 driver
» 15 lib
» [ script
4 = result
» = log
= screenshot
= test-report
» e src
[= target

[} pom.xml
1) runAllxml

|¥} runSingle.xml

T H B2 —> maven TUH, K24 maven A] ULEHZIFHBIIATMEDIH . B3 NI
ERH Gar 1), N ZAE pom.xml SCAF R BCE A < 580w,
® src/test/java: maven Ji H FHAEHEN A AL B H 5%
B com/incite/logistics: )i H H =%
€ base: HI[HH ) BaseParpare.java H T HJ4A Hb i Yo 45 A1 45 A0 o #% i A
€ pages: fFICEANTUH _ERFICERM java 28 (AN DU E — A java 28, HLHIF
T A B L E A BT TR
& testcase: fFBUNAHBIRIHR, tHF FZBIGEBERFM ) HX (B,
FEASF H AR A &AM 51
& util: FROZEEAERAS H 3, lLH SR HETA 2 /) java 25: SelectExplorer.java
F1 SeleniumUtil.java
® SelectExplorerjava: Jii44 8 S, X — NN ARE R B AR
® SeleniumUtil.java: 3% | selenium FTA % FH 7B B € X771k
B com/netease/qa/testing: XM ZHITF K I— N ET testng MIFd:, 44U fi:
arrow, G RTLASEILThAEEE : HGIR B EIRK. KRIGHE < 3 shalE, &
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BRI L L testng BV EOML, HZNZEELER (LS — R BIHEN T,
{HRZRt 5 — R EK, FBIRIIHAT, arrow BES IS — 5 R IId 2R, TREE
5 IR E RO
® config: 17 logdj WIHC & X (log4j.properties ) Al arrow i 14 1 It & X
(config.properties) ,5< T logdj AL E M L ELLL B &, AT HIXH, X BT arrow
I HC L -
config.properties: testng fdiff arrow FJHC & SO, N AU :
retrycount=n //7E S EHILREL, HURABIBIAMNZ 5, F#ln (n2IERHD
sourcecodedir=src/test/java/com/incito/logistics/testcase/ //%5 & Ml FH 41 (1) H 5%
sourcecodeencoding=UTF-8 //1& & JF L I 775 dwhd

® extral: fFA4IKZ), PRI =T7 A Hx
driver: fEIBCAN A& BIAS B ZOAS R0 Y 253 B 1Y driver
lib: BRI jar @, ELUIE K jar 7E maven G ER AT (HOHwmSE
1), BtRREER, ET L HEESAEH
script: A7 R = 77 I BEIA 58 B 4k
® result: RIS R H 5
log: 715 logdj M HA&, AT 7G4 24 )
screenshot: A7 BRI A1 £ 9 T2 8k 1)
test-report: AR EA L H S, L HTML 7087, WEATR, B E—fr 5%

“2

MIK: H
e M. zip
(IR R -
HMethods | Scenarios - - Total Included | Excluded
Test Passed Passed # skipped | # failed Time Groups Groups
= 6 6 0 57.6 seconds
Class Hethod Authors ¥ of Running
Scenarios Counts
FF — failed

HFE — passed

com incito. logistics. testcase. login. LoginPage 5 Fail Password Test loginFailTest Password

com. incito. logistics. testcase. login. LoginPage 7_Fall_Incorrect_Password Test | loginFailTest incorrectPassword i ;.1

com. incito. logistics. testcase. login. LoginPage 1 _UI_Test

® pom.xml: maven NECE M, DIHZOEE, HTMWEIH. B3~ HE o6 L
JE A testng. jenkins JiC & AR EE Rl SE

® runAll.xml: X2 testng MIECE CHF, HTAFHGHE IR EEE LR EE &, o Y
PIFCE . IMAZE =7t T Carrow $8i4 ) B BIHAT RIS (2 A28 72 HL20FE,
Ji 7 AT 38 A T AT PA R =2 3 AT 55D DL B HAT IR . P AU
runAll B4 BB SCHRAE T AT HEAS web T00H 0 AT A AR R Ay FH 48] E4 0k


http://blog.csdn.net/azheng270/article/details/2173430/
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® runSinglexml: A runAllxml —#¢, AR, AT B T ERECERAS B
WIS, R EEEARE OABD, PRl L. EAnIRA runAllxml 58
TR, ARSI MG R, B 56 504 log,  An SR 2 AAS ] RLat 25 ik
A, WikTEEe 2 5t % runSingle.xml 2 Bl—i21 b 1.

=. WfERR

v FHFTEERI 2T windows &

3.1, ®IEEE JDK
1. F#zeds DK 7(32bit), AT F#ER
2. ME jdk AT E, SREFOAEE

3. 2. ZIFECHE Maven

T#E maven, 53k FEk

B & maven AEIAR S, R RAE WAL E

N #E 2% Eclipse (32bit) 2R FEk

fit K WA N #0041 Eclipse 2R R H 3, X Eclipse.exe F1FF
AT maven integration for eclipse

FTHF Eclipse 2 #1424 ->Help->Eclipse Marketplace... 1/&]:

R i

Run Window

w3 e Welcome

AN O o

o | (@ Help Contents
7 Search
Dynamic Help

r] Key Assist... Ctrl+Shift+L
Tips and Tricks...
Cheat Sheets...

Eclipse Marketplace...
Check for Updates
Install New Software...

About Eclipse

7. 1#Z” maven integration for eclipse” % %%, WK, i install Z3E 2 T Eclipse


http://download.oracle.com/otn-pub/java/jdk/7u67-b01/jdk-7u67-windows-i586.exe
http://jingyan.baidu.com/article/6dad5075d1dc40a123e36ea3.html
http://apache.dataguru.cn/maven/maven-3/3.2.2/binaries/apache-maven-3.2.2-bin.zip
http://blog.csdn.net/lijingronghcit/article/details/9167075
http://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/kepler/SR2/eclipse-standard-kepler-SR2-win32.zip
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& Eclipse Marketplace

= &=
Eclipse Marketplace D
Select solutions to install. Press Finish to proceed with installation. ?
Press the information button to see a detailed overview and a link to more information.
Search |Recent | Popular | Installed | & July 07/31
Find: maven integration for eclipse 2 2| [l Markets -] (Al Categeries -] [z
D Installs: 76.1K (0 last month) Learn more
Maven Integration for Eclipse (Luna and newer) 1.5 L
== m2e provides comprehensive Maven integration for Eclipse. You can use m2e to manage both simple and multi-module Maven projects, exscute Maven bulds via the.. more info 1
== by Eclipseorg, EL
= build java maven Development maveney
313 D Installs: 694K (17,385 last month) Install
)5 2 J5 7E Eclipse 2 HF:->Window->Preferences /i F] T, 8% maven T, XMt
T EEE 2 M (nED:
—. Installations, 57 Add, F8H 5 =P T EH) maven [ H X, Ik K 2
e:\Dev\appache\maven(iif. /& maven home #%4%), 5 B IILAJE B H 1) Global Settings
from installation diectory 2 HZE/7%] maven Fi7EES S T conf/settings.xml SCAF
(settings.xml /& maven W& B AL E S, B0 LAE E ARG EAF RS R o] LTE &
v - ymn . . . settings.xml
R R ), 7R AR AT IR E T settings.xml S ENif]
CAME iR hER RS OFESEK maven G
% Preferences =] @
type filter text Installations LS Ty
+ General i Select the installation used to launch Maven: -
» Android
. Ant External EX\Dev\apacheymaven (3.2.1) Add...
. CfCes ] Embedded (3.0.4/1.4.0.20130531-2315) -
Edi
» Help =
» Install/Update Remove
> Java
4 Maven = =
Archetypes
Discovery

Installations Mote: Embedded runtime is always used for dependency resalution, but does not

use global settings when it is used to launch Maven. To learn mare, visit the Maven
Templates web page.

User Interface

Lifecycle Mapping

U Setti - - - - -
SEr setungs Global settings from installation directory (open file):

Warnings
- Plug-in Development EA\Deviapache\maven\confisettings.xml Browse.
» Run/Debug
» StartExplorer i
] T »
=
'\?JI [ OK l l Cancel

. User Settings: 1% & (User Settings) iX L2 FLIKFE € —> settings.xml iX B /&
AT R AR &, YR IE A, WIA BUTH A settings.xml &4 R A8 & EXFFrE .
BT 8 m o 32 it B settingsxml f5 & T A M & FE KK BN
e:\Dev\apache\maven\repo\m2 iX/& maven HJH FH, WR repo\m2 HEALELE,
W EE, ST settings.xml TN repo H3k 1EA user settings FIFCE SO Wik
AR ARG 2E H %, TE B S NIA B E A settings.xml SCEEHR

<localRepository>E:/Dev/apache/maven/repo/m2</localRepository> B[]
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o 2=
User Settings =N v v

User Settings (open file):

EnDeviapache\mavenirepolsettings.xml Browse...

Update Settings

Local Repository (From merged user and global settings):

E:/Dev/apache/maven/repo/m2

3.3, MLE git

) M Eclipse H1# 28 %% egit Fhiff
2. fic & egit, ¥ : Eclipse > £} ->Window->Preferences #1 o 1 JF, #
& ”"git”(Team->Git->Congiguation->Add Entry..),%8 J5 73l 37— key A user.email Fll
user.name A&, value 73H3E FARE S HIER github 1) email, name AJ LLRE(E
HE (X556
@#:
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I £ preferences

gif
4 Team
4 Git
Committing

History

Projects
Synchronize

4| n

@

K.

Configuration

Configuration
Confirmations ar

Label Decoration

Window Cache

General

[¥] Always run in background

[ Keep next/previous editor, view and perspectives dialog open

[ Show heap status

Workbench save interval (in minutes): 3

Open mode
@ Double click
() Single click

Select on hover

Open when using arrow keys

Mote: This preference may not take effect on all views

User Settings

System Settings | Repository Seﬂings|

l Restore Qe{aults] [

Apply

| o

|| cancel

]

Key

4 User
emall
name

3.4, &3 testng

Location: Ch\Users\Administrator.gitconfig

Value

308733146@qqg.com

wangyang

ELHEM Eclipse F18 % %23 testng BIA], AN EHAMNC B

Remove

- .
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3.5+ eclispe P —L & E

1. B Eclipse w5 N UTF-8, #EEUWIR: Eclipse 3HLA%->Window->Preferences s i 4T
JF->General->Workspace->Text file encoding —>other:UTF-8, U1 :

Text file encoding Mew text file line delimiter
(7) Default (GBK) @ Default (Windows)
@ Other; UTF-2 - i) Other: | Windows
2. B4 Installed JREs #4145, #/EUIN: Eclipse 2 #L42->Window->Preferences fi i 4T

FF->Java->Installed JREs->Edit->%A fG S FE Al [ 0 IR 2 25 051 java [ jdk H =%, teandk
f]: C:\Program Files (x86)\Java\jdk1.7.0_65

=

Installed JREs P~ ~

1

Add, remove or edit JRE definitions. By default, the checked JRE is added to the
build path of newly created Java projects.

Installed JREs:

Mame Location Type Add
[/| =i jre7 ... C:\Progra.. Standard V..

Duplicate...
Remove

Search...

111

3.6+ M github EEETH

1. N Eclipse ZH.F~->window->Show view->other->18 2% git->i% ¢ Git Repositories, Z&
J& i oK



O
Lesting
$k ﬁ: f)ﬂ\l] 'Et W.l www.51testing.com

r%%wﬁm =0 EER ==

git
4 = Git
J].;—“i Git Interactive Rebase
4 Git Reflog
|5 Git Repositories|
i¥y Git Staging
[:L Git Tree Compare

| ok || cancel |

2. 2 JG Eclipse H & HELIXFE— ML :
155 Git Repositories 32 DR BE S B E ¥ =8

b {[] automation [master] - C:\Users\Administrator\git\automation\.git!
t [] Test_Tools [master] - C\Users\Administrator\git\Test_Tools\.git

3. TT.ﬂ:JH:IWiJ.J:: ht.tps://github.com/stephenwanglOll/automation, IR G T B R

HTTPS clone URL

https://fgithub.cc

s le=E )L

You can clone with HTTPS,
S5H, or Subversion. ®

[ Clone in Desktop

<> Download ZIP


https://github.com/stephenwang1011/automation
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F "q'l |
4. S e ELE S 5 A clone BIbR: © T, AR S HI k2 B3R,
.
£ Clone Git Repository | o [E- 3]
Source Git Repository IT|
Enter the location of the source repository. : N d
Location
URL v https://github.com/stephenwangl011/automation.git |Lgca| File...
Host: github.com

Repository path: /stephenwangl0l1l/automation.git

Connection

Protocol:

Port:

Authentication

User: stephenwangl011
Password: sesEBBRRIRRS

Store in Secure Store

Hrpy
Authentication
User: stephenwang1011
Password: sessssesse e

Store in Secure Store [V]

i EIE R github F7 A2 F1EY, TR IR 256 M— 1.

5. md EEIR“Next” B2 NANTUMH, HEE213E T “Import all existing projects after clone
finshes”



O
tescing
R

www.51testing.com

| @ Clone Git Repository = = “‘
Local Destination
- p (G |
Configure the local storage location for automation. - '
-
Destination
Directory: C:\Users\CYJ\git\automation Browse
Initial branch: master v
[T]Clone submodules
Configuration
Remote name: origin
Projects
[V]limport all existing projects after clone finishes:
Working sets
[[1Add project to working sets
Vorking sets: Select...
G S
2 = Back Next = Cancel

6. miidy “Finish” BimA]

2 Cloning from https://github.com/stephenwang1011/a.. = P

Cloning from https://github.com/stephenwang1011/automation.git

[JiAlways run in background:

1 Run in Background ] Cancel Details ==

Pl LN s

7. 5EK clone 2 J&, £1E package explorer & ~H github FHIIH,
anfE
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ff Package Explorer 52 & ¥ = 8

b Y3 = appium [automation master]
b =2 DailyDemo
[ :—é logisticsautotest [automation master]

b oy = red [Test_Tools master]

8. HAH logisticsautotest i H @2 i 624X web 3w i) B BHALIK, XANIHRIE T
FER) maven HET. BAEPXATE, REA%E->naven—>Update Project. . —>
SRJEHZ T B mids OK B W] . H IR AT H maven 23 #0000 H 48 LL A - Fil
ffE, FENSK A, Arree T Mg el HAth 5 R S8R, 230 LT BL 7
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£ Update Maven Project

Update Maven Project

Select Mawven projects and update options

¢

Available Maven Codebases

[|i= red

[ &= appium

= logisticsautotest
[ = DailyDemo

[C] Offline
Update dependencies

[ Force Update of Snapshots/Releases

Update project configuration from pom.xml

Refresh workspace resources from local filesystemn

Clean projects

@

Select All
Deselect All
Expand All

Collapse All

i

J |

Cancel

3.7+ PATHEA B

1. R PL DRI £ sc BEIE H G iR,  BARIEH runAll.xml->Run as ->TestNG Suite

= target Build Path
[ [= test-output R

5 config.prope

= fileLog e Import..

% pom.xml sy Export..

|,§b runAllsml| & Refresh

|7y runSinglexm

oy Assign Working Sets...

b =y = red [Test_Toqg
Validate
Profile As
Debug As
Run A

f@ Git Repositories 53 fn
. . Compare With

> [] automation [ma .

Replace With

b [1 Test_Tools [mas
StartExplorer

=

3
Alt+5hift+T »

F3

Search:

EE All Tests Eﬁ Failed Tests| Summary|

i 1 TestNG Suite

Run Configurations...

Alt+Shift+¥, G
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2. VRIS s AT il BT 1 A U 51

3.8, MAREEK

1. W SR ULARAR B AR b Y A B BRI, MR AR %%, TLATE runAllxml B
&S, aiffsel, wfCAE BT IR sCrE, BB T VeGR4
E T
T fE I IR ? $T 7T config.properties, ZE(Z4 retrycount=n  n 24
HABRL B AT,

0. jenkins ¥FEEEE MR

4.1. %% jenkins

1. BEM F# jenkins windows 2235 if: it F#L
2. R exe XHPATLHE

4.2, BCE jenkins (&J7)

1. fE jenkins )& ME 2N jenkins.xml H1[1)
<arguments>-Xrs -Xmx256m
-Dhudson.lifecycle=hudson.lifecycle.WindowsServiceLifecycle -jar "%BASE%\jenkins.war"
--httpPort=8080</arguments>
N
<arguments>-Xrs -Xmx256m —Dfile=utf-8
-Dhudson.lifecycle=hudson.lifecycle.WindowsServicelifecycle -jar "%BASE%\jenkins.war"
--httpPort=8080</arguments>
X3P FERA T RV jenkins 4 A SC HH I EL RS (115 Dl
2. W EEF N http://localhost:8080 IS 23T JT jenkins 1T, 1]



http://mirrors.jenkins-ci.org/windows/latest
http://localhost:8080/
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| Eienkinsz2EaTtienk x |[@ EleknsmERmIE x | Vouns hip//39873314. x | G Dashboard Uerkins] < [
= 0 [1localhost:8080

f Jenkins C) )
panea=Folid iy

Jenkins

= e [EEaIt:)

Al
& A~ :
. s w Name | et d: 3] ik EPxEsEma
= fEERE

O, mE#E

AutoTest 9 days 6 0T -#3 9 days 15 A - #1 15 3]

A I N Elfi EJRSS£# [JRSS [ RSS BAMHE
& FHER
4. Credentials

LU =
BA S b 5 AR 55

ok 31k =
# ®E
1| =i/
2| =i

[ RS iol SEH FIE: 2014-8-18 15:44:27  RESTAPI  Jenkins ver. 1574I

3. fEEIETE “REEH” SIEMEEH, ErIEEFH I git plugins fl github plugins
PR EAF AT 2245, 23 JE HE jenkins 422K

4. FHIFN “REEH” > “REWE” HTEFHANLE

5. Maven fiLE, K

Maven Configuration

Default settings provider .
gsp Use default maven settings v

Default global settings provider
g 93 P Use default maven global settings v

6. Git iLE: W AFaLAR T git ZJEH1E gitexe B1e, HAIDLEEMARCELAEH
Az, HANFRINRTF AN 2R git, WAl

Default

Path to Git executable C\Gitlemdigit exe

B )

7. FiiE github {4 44 A4S

Git plugin
Global Config user.name Value stephenwang 10711 @
Global Config user.email Value 398733146@aq com @

8. iy LHIHZEH B RT ORAF L T AR I

4.3. FEMETH

1. s TR AL
2. HEE—A maven IiH,
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Hem B totest

3.

6.

#HE—ahREMEATA
ERJenkins I EEhEE Jenkins B2 E S HASCMANTEMZ RS X MZFHNE, EEA LR HLEIMIRS

® {3 —4-maveniH
9 —mavenlfi B Jenkins A fRRIPOMI (2 # e Ll X A RSS2 RS

HE—1TEERERE
ERT2EMBME FINS RN PalEEag 5
mE— RS
%gtﬁi“?ﬂf{-%f‘tiﬂﬁiaimﬁ?z%&wenkmsE*H—I—% FHEEIBTIDENSE L IZa tlitlenkins fEAIRATE BB RARNEHEE 25 21 THEEEFH

REHEaMItem
EEHMIEETR

OK

PR, & FE git, URL T ATH H 2tk

RaEd
None
Cvs
CV'S Projectset
®) Git
Repositories Repository URL @
@ Please enter Git repository.
Credentials
- none - v
o Add @
=ik
Add Repository Delete Repository
e > ] = A =z =) /=3
PSR E N il 4% 213% Poll SCM, HAERPHIA: H8* **FE2: KR EF/N\HA
v g
EIBATHH
ARk s
Build whenever a SNAPSHOT dependency is built @
Build after other projects are built @
Build periodically @
Build when a change is pushed to GitHub
¥ Pall SCM @
FiEs Hgee-
(7]
o P
Would last have run at 2014588188 ZE8i— 408840053193 CST: would next run at 2014588198 2= 40884004 19% CST
Ignare post-commit hooks @
=g VA o 4 . LA
Mgt faeifiiH pom.axml. ATiHEE: logistics/pom.xml. Goals and options i A\
test B AJ
Build
Root POM logitics/pom._xml (7]
Goals and options tast ®

@& =

s ey LSS T v B PR AT A2 2
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4.4. FHPITHE

1. {E jenkins B 012 2| H CHIA # 2 1) maven T H :test
2. wWEpTR: AT FE

All | &
S w Name | 4 3] FiRm ERFEHE
L AutoTest 9 days 6 < - £3 9 days 16 < AT - #1 44 513 i.‘z)

Rba# T FE
2 (Eamt)

Fi. HAiiBd

5.1, WiHEEMTE

— AR firefox H{dif4: firebug A1 firepath ] DURSHEE AL L e AL B, HoAth i) %6 28 ] LLis
WA HE LR BE N HILR

5.2, At selenium A [J3CHY

1. Selenium Testing Tools Cookbook 1 (3EENAEL: 2073)
2. selenium webdriver #>] (3EEUG:. dfs50)

201448 A


http://yunpan.cn/QaAXSEFubNtNA
http://yunpan.cn/QaAXMFghkQq6z

